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Preface
This guide explains the integration between Service Desk and OpenView 
Operations for Windows . With the information in this guide you can 
install, configure and perform the various tasks available with this 
integration. 

This guide is intended for IT administrators who will install and 
configure the integration, and for users who will perform the integration 
tasks. 

To install and configure the integration you must have knowledge of both 
the OpenView Operations application and Service Desk.

This guide is organized as follows:

• Chapter 1, “Introduction,” describes the architecture of the 
OpenView Operations Integration and gives a brief explanation of 
what the integration possibilities are.

• Chapter 2, “Installation,” describes the installation steps that need 
to be performed on Service Desk and on your OpenView Operations 
server.

• Chapter 3, “OVO for Windows and Service Desk Configuration,” 
explains how to configure the integration when using OpenView 
Operations for Windows.

• Chapter 4, “User Tasks,” provides examples on how to use the 
different features supplied with this integration.

• Chapter 5, “Troubleshooting,” contains information on the default 
locations of installed files and other information that may be helpful 
in solving problems with the integration.
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Revision History

When an edition of a manual is issued with a software release, it has 
been reviewed and tested and is therefore considered correct at the date 
of publication. However, errors in the software or documentation that 
were unknown at the time of release, or important new developments, 
may necessitate the release of a service pack that includes revised 
documentation. Revised documentation may also be published on the 
Internet, see “We Welcome Your Comments!” in this preface for the URL. 

A revised edition will display change bars in the left-hand margin to 
indicate revised text. These change bars will only mark the text that has 
been edited or inserted since the previous edition or revised edition.

When a revised edition of this document is published, the latest revised 
edition nullifies all previous editions.

Table 1 Revision History

Edition and Revision 
Number Issue Date Product Release

 OpenView Operations 
Integration, 
Administrator’s Guide, 
First Edition

November, 2002 Service Desk 4.0, 
Integration Service 
Pack
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The Service Desk Documentation
Service Desk provides a selection of books and online help to assist you in 
using Service Desk and improve your understanding of the underlying 
concepts. This section illustrates what information is available and 
where you can find it.

NOTE This section lists the publications provided with Service Desk 4.0. 
Updates of publications and additional publications may be provided in 
later service packs. For an overview of the documentation provided in 
service packs, please refer to the readme file of the latest service pack. 
The service packs and the latest versions of publications are available on 
the Internet, at http://support.openview.hp.com/cpe/patches and 
http://ovweb.external.hp.com/lpe/doc_serv respectively. See the section 
“We Welcome Your Comments!” in this preface for the URLs.

• The Readme.htm file on the Service Desk CD-ROM contains 
information that will help you get started with Service Desk. It also 
contains any last-minute information that became available after the 
other documentation went to manufacturing. 

• The HP OpenView Service Desk: Release Notes give a description of 
the features that Service Desk provides. In addition, they give 
information that helps you:

— compare the current software’s features with those available in 
previous versions of the software;

— solve known problems.

The Release Notes are available as a PDF file on the HP OpenView 
Service Desk 4.0 CD-ROM. The file name is Release_Notes.pdf.

• The HP OpenView Service Desk: User’s Guide introduces you to the 
key concepts behind Service Desk. It gives an overview of what you 
can do with Service Desk and explains typical tasks of different types 
of Service Desk users. Scenario descriptions are provided as 
examples of how the described features could be implemented.

The User’s Guide is available as a PDF file on the HP OpenView 
Service Desk 4.0 CD-ROM. The file name is User’s_Guide.pdf.
 9
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• The HP OpenView Service Desk: Supported Platforms List contains 
information that helps you determine software requirements. It lists 
the software versions supported by Hewlett-Packard for Service 
Desk 4.0.

The Supported Platforms List is available as a PDF file on the HP 
OpenView Service Desk 4.0 CD-ROM. The file name is 
Supported_Platforms_List.pdf.

• The HP OpenView Service Desk: Installation Guide covers all aspects 
of installing Service Desk.

The Installation Guide is available as a PDF file on the HP 
OpenView Service Desk 4.0 CD-ROM. The file name is 
Installation_Guide.pdf.

• The HP OpenView Service Desk: Administrator’s Guide provides 
information that helps application administrators to set up and 
maintain the Service Desk application server for client usability. 

The Administrator’s Guide is available as a PDF file on the HP 
OpenView Service Desk 4.0 CD-ROM. The file name is 
Administrator’s_Guide.pdf.

• The HP OpenView Service Desk: Data Exchange Administrator’s 
Guide explains the underlying concepts of the data exchange process 
and gives instructions on exporting data from external applications 
and importing it into Service Desk. The data exchange process 
includes importing single service events and batches of data. 

The Data Exchange Administrator’s Guide is available as a PDF file 
on the HP OpenView Service Desk 4.0 CD-ROM. The file name is 
Data_Exchange.pdf.

• The HP OpenView Operations Integration Administrator’s Guide 
explains the integration between Service Desk and VantagePoint for 
Windows and UNIX . This guide covers the installation and 
configuration of the integration and explains how to perform the 
various tasks available with the integration. 

The OpenView Operations Integration Administrator’s Guide is 
available as a PDF file on the HP OpenView Service Desk 4.0 
CD-ROM. The file name is VPO_Integration_AG.pdf.
10



• The HP OpenView Service Desk: Migration Guide provides a detailed 
overview of the migration from ITSM 5.7 to Service Desk 4.0, to 
include an analysis of the differences in the two applications. 
Detailed instructions in this guide lead through the installation, 
configuration and other tasks required for a successful migration. 

The Migration Guide is available as a PDF file on the HP OpenView 
Service Desk 4.0 CD-ROM. The file name is Migration_Guide.pdf.

• The HP OpenView Service Desk: API Programmer’s Guide contains 
information that will help you create customized integrations with 
Service Desk. This guide depicts the API structure, and explains 
some of the basic functions with examples for using the Application 
Programming Interface (API) provided with Service Desk. The API 
extends the HP OpenView Service Desk environment by providing 
independent programmatic access to data-centered functionality in 
the Service Desk application server environment.

The API Guide is available as a PDF file on the HP OpenView 
Service Desk 4.0 CD-ROM. The file name is API_pg.pdf.

• The HP OpenView Service Desk: Web API Programmer’s Guide 
contains information that will help you create customized 
integrations with Service Desk using the Service Desk Web API. This 
API is particularly suited for developing Web applications. 

The Web API Programmer’s Guide is available as a PDF file on the 
HP OpenView Service Desk 4.0 CD-ROM. The file name is 
Web_API_pg.pdf.

• The HP OpenView Service Desk: Data Dictionary contains helpful 
information about the structure of the application.

The Data Dictionary is available as an HTML file on the HP 
OpenView Service Desk 4.0 CD-ROM. The file name is 
Data_Dictionary.htm.

• The HP OpenView Service Desk 4.0 Computer Based Training (CBT) 
CD-ROM is intended to assist you in learning about the functionality 
of HP OpenView Service Desk 4.0 from both a user and a system 
administrator perspective. The CD-ROM contains demonstration 
videos and accompanying texts that explain and show how to 
perform a wide variety of tasks within the application. The CBT also 
explains the basic concepts of the Service Desk application. 
 11



The HP OpenView Service Desk 4.0 Computer Based Training (CBT) 
CD-ROM will be shipped automatically with the regular Service 
Desk software. The CBT will be available for shipment shortly after 
the release of the Service Desk software.

• The online help is an extensive information system providing:

— procedural information to help you perform tasks, whether you 
are a novice or an experienced user;

— background and overview information to help you improve your 
understanding of the underlying concepts and structure of Service 
Desk;

— information about error messages that may appear when working 
with Service Desk, together with information on solving these 
errors;

— help on help to learn more about the online help.

The online help is automatically installed as part of the Service Desk 
application and can be invoked from within Service Desk. See the 
following section entitled “Using the Online Help” for more 
information.

Reading PDF Files

You can view and print the PDF files with Adobe  Acrobat  Reader. 
This software is included on the HP OpenView Service Desk 4.0 
CD-ROM. For installation instructions, see the readme.htm file on the 
CD-ROM.

The latest version of Adobe Acrobat Reader is also freely available from 
Adobe’s Internet site at http://www.adobe.com.

Using the Online Help

You can invoke help from within Service Desk in the following ways:

• To get help for the window or dialog box you are working in, do one of 
the following:

— Press F1.

— Click the help toolbar button .
12
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— Choose Help from the Help menu.

— Click the help command button  in a dialog box. 

• To search for help on a specific subject using the table of contents or 
the index of the help system: choose Help Contents & Index from 
the Help menu.

When you are in the help viewer, you can find help on how to use the help 
system itself by clicking the Help toolbar button:

Service Desk also provides tooltips and “What’s This?” help for screen 
items like buttons, boxes, and menus.

A tooltip is a short description of a screen item. To view a tooltip, rest the 
mouse pointer on the screen item. The tooltip will appear at the position 
of the mouse pointer.

“What’s This?” help is a brief explanation of how to use a screen item. 
“What’s This?” help generally gives more information than tooltips. To 
view “What’s This?” help:

1. First activate the “What’s This?” mouse pointer in one of the 
following ways:

• Press Shift+F1.

• Click the “What’s This?” toolbar button .

• Choose What’s This? from the Help menu.

• In dialog boxes, click the question mark button  in the title bar. 

The mouse pointer changes to a “What’s This?” mouse pointer .

2. Then click the screen item for which you want information. The 
“What’s This?” help information appears in a pop-up window.

To close the pop-up window, click anywhere on the screen or press any 
key on your keyboard.
 13



Typographic Conventions
The table below illustrates the typographic conventions used in this 
guide.

Font What the Font Represents Example

Italic References to book titles See also the HP OpenView Service 
Desk: Installation Guide.

Emphasized text Do not delete the System user.

Bold First-time use of a term that is 
explained in the glossary

The service call is the basis for 
incident registration.

Courier Menu names You can adjust the data view with 
the commands in the View menu.

Menu commands Choose Save from the menu.

Button names Click Add to open the Add Service 
Call dialog box.

File names To start the installation, 
double-click setup.htm.

Computer-generated output, such 
as command lines and program 
listings

If the system displays the text
C:\>dir a:
The device is not ready
then check if the disk is placed in 
the disk drive.

Courier bold User input: text that you must 
enter in a box or after a command 
line

If the service call must be solved 
within 30 minutes, enter 30.

Courier italic Replaceable text: text that you 
must replace by the text that is 
appropriate for your situation

Go to the folder X:\\Setup, where 
X is your CD-ROM drive.
14



Helvetica bold Keyboard keys

A plus sign (+) means you must 
press the first key (Ctrl in the 
example), hold it, and then press 
the second key (F1 in the 
example).

Press Ctrl+F1.

Font What the Font Represents Example
 15



We Welcome Your Comments!
Your comments and suggestions help us understand your needs, and 
better meet them. We are interested in what you think of this manual 
and invite you to alert us to problems or suggest improvements. You can 
submit your comments through the Internet, using the HP OpenView 
Documentation Comments Web site at the following URL:

http://ovweb.external.hp.com/lpe/comm_serv

If you encounter errors that impair your ability to use the product, please 
contact the HP Response Center or your support representative.

The latest versions of OpenView product manuals, including Service 
Desk manuals, are available on the HP OpenView Manuals Web site at 
the following URL:

http://ovweb.external.hp.com/lpe/doc_serv

Software patches and documentation updates that occur after a product 
release, will be available on the HP OpenView Software Patches Web site 
at the following URL:

http://support.openview.hp.com/cpe/patches
16
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1 Introduction

The OpenView Operations Integration includes a variety of different 
integration options. This chapter provides a brief explanation of the 
architecture and the integration options available.
Chapter 1 17



Introduction
The Architecture
The Architecture
The OpenView Operation integration is only available for OpenView 
Operations for Windows. The following diagram shows its architecture 
and how the integration possibilities fit into the architecture.

Figure 1-1  OpenView Operations for Windows Architecture
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Introduction
Integration Possibilities
Integration Possibilities
The Service Desk integration with OpenView Operations makes it 
possible to:

• Import nodes and services into Service Desk.

• Send events from OpenView Operations to Service Desk.

• Reflect OpenView Operations updates in Service Desk.

• Send acknowledgment messages and message annotations from 
Service Desk to OpenView Operations.

• View Service Desk configuration items from OpenView Operations 

• View OpenView Operations service state from a browser.

• Generate an OpenView Operations message from Service Desk.

• Monitor Service Desk processes and error log files.

Importing Nodes and Services into Service Desk

Node information from OpenView Operations can be extracted and 
imported into Service Desk as configuration items. Data Exchange tasks 
are supplied a configurable extractor and import mapping with default 
settings. 

There are a number of Data Exchange Tasks for Windows users. They 
require an ODBC link to your Oracle  database. For more information 
see, “Importing Nodes into Service Desk” on page 62.

Sending Events From OpenView Operations

OpenView Operations for Windows users can send event information to 
Service Desk using a WMI policy that intercepts OV_Messages and uses 
a Visual Basic script called ovo-Sd.vbs to call sd_event and forward 
attributes to Service Desk. SD_event creates a corresponding incident in 
Service Desk. 

For more information see “Sending Events From OpenView Operations” 
on page 64.
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Integration Possibilities
Reflecting Updates Done in OpenView Operations

Changes made to OpenView Operations messages from the OpenView 
Operations management console or the API will be reflected in Service 
Desk. A WMI policy that registers the event class 
OV_Message_ChangeEvent is used. When a message change occurs, for 
example severity change or message text change, the sd_event program 
in Service Desk will be called to update the corresponding incident. See 
“Reflecting Updates Done in OpenView Operations” on page 65 for more 
information.

Sending Annotations and Acknowledgments 

Annotations can be sent to OpenView Operations when an incident 
changes and an acknowledgement can be sent when the incident is 
closed. Agents on the OpenView Operations server are sent commands 
based on database rules created in Service Desk.

See “Sending Annotations to OpenView Operations” on page 67, and 
“Sending Acknowledgments to OpenView Operations” on page 69 for 
more information.

Viewing Service Desk CIs from OpenView Operations

OpenView Operations users can select a node in OpenView Operations 
and launch a tool for opening the corresponding incidents for that 
configuration item in Service Desk. Service Desk and OpenView 
Operations must be installed on the same machine. For more 
information see, See “Viewing Service Desk CIs from OpenView 
Operations” on page 20 for configuration information and “Viewing 
Service Desk CIs from OpenView Operations” on page 71 for information 
on using the feature.

Viewing OpenView Operations Service State From a 
Browser

After installing and configuring one of the recommended Web Servers, 
OpenView Operations service state can be viewed from a browser. See 
“Viewing OpenView Operations Service State” on page 72.
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Generating an OpenView Operations Message From 
Service Desk

This feature is available for OpenView Operations for Windows. Smart 
Actions must be configured and the OpenView Operations agent must be 
installed on the Service Desk client.

For more information, See “Generate an OpenView Operations Message 
from Service Desk” on page 50 and “Generating an OpenView Operations 
Message From Service Desk” on page 74.

Monitoring Service Desk and Integration Processes

OpenView Operations log file policies can be used to monitor Service 
Desk error log files and the Service Desk application server to ensure the 
integration is functioning properly. You can monitor errors in the Service 
Desk application server and the OpenView Operations management 
server. The policies can be used to match specific log file lines, assign 
variables out of the intercepted lines and conduct pattern matching. 
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2 Installation 

This chapter explains the installation tasks for the Service Desk 
application server and OpenView Operations for Windows.
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Refer to the HP OpenView Service Desk: Installation Guide for detailed 
information on system requirements.

NOTE To create a WBEM ODBC source driver, WMI version 1085 core 
components are required:

• For Windows NT 4 systems, install the WBEM ODBC source driver, 
available on the VantagePoint Installation CD-ROM as 
\wmi\wmicore_1085.exe

• For Windows 2000 systems, install theh WBEM ODBC source driver, 
available on the Windows 2000 professional CD-ROM in 
\Valuadd\Msft\Mgmt\Wbemodbc.
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The OpenView Operations Integration includes a number of files and 
tools that need to be installed on the Service Desk and the OpenView 
Operations servers. The following checklist shows the recommended 
order of installation:

1. OpenView Operations application (refer to the OpenView Operations 
documentation);

2. Web Server supplied with the OpenView Operations application 
(refer to the OpenView Operations documentation);

3. Service Desk server application, and Data Exchange installed.

4. Service Desk database;

5. OpenView Operations agents on Service Desk server (refer to the 
OpenView Operations documentation);

6. On your OpenView Operations for Windows server:

• Follow the instructions in the Readme file distributed with the 
Integration service pack for OVO for Windows 7.1.

• Service Desk agents on all OpenView Operations for Windows 
machines.

• OvServiceExport.zip is included in the Integration pack if you 
want to use the HTML Service Viewer.

• Run database scripts; ovo7-sd40_ora.sql for an Oracle 
database, or ovo7-sd40_sql.sql for an SQL SERVER database.

TIP OpenView Operations for Windows users can use either the Apache, or 
the Microsoft® IIS Web server supplied with OpenView Operations. To 
check if Microsoft IIS is installed, type the following in your browser: 
http://<server>/scripts/OvServiceExport.exe?-format+html.

To check for Apache: 
http://<server>:<portnumber>/cgi-bin/OVServiceExport.exe?-fo
rmat+html
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NOTE The OpenView Operations Integration for Windows does not work on 
multiple Service Desk application servers. You can only use it with one 
Service Desk application server, because of limitations in sd_event and 
in the distribution and function of the monitoring policies. 
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Installing on the Service Desk Server

If you are running OpenView Operations for Windows on a different 
application server than Service Desk, see “OpenView Operations for 
Windows Server” on page 28.

No extra components are required on the Service Desk server.
Chapter 2 27



Installation
OpenView Operations for Windows Server
OpenView Operations for Windows Server
Files and tools need to be installed on the OpenView Operations servers 
for the integration to work. This section explains the integration 
installation on an OpenView Operations for Windows server. 

A table showing the key integration files and default locations for the 
OpenView Operations for Windows server, can be found in Chapter 5, 
“Troubleshooting,” on page 77.

To install the integration on your OpenView Operations for Windows 
server follow the instructions in the Readme file distributed with the 
Integration service pack for OVO for Windows 7.1.

Installing the HTML Service Viewer

The HP OpenView Operations HTML Service Viewer makes it possible 
for you to view services from a browser. OpenView Operations for 
Windows uses a Web Server to perform this function. Refer to the HP 
OpenView Service Desk: Installation Guide for additional information 
about the Web Servers supported. To install the integration you will need 
to first copy OvService Export.exe. to the correct directory.

For Apache users, OvServiceExport.exe needs to be put in a directory 
that Apache can run CGI scripts from (scripts directory).You can find 
this file in the zipped file OvServiceExport, which has been created by 
the integration installation program. The default directory is cgi-bin. 
Apache normally uses the System account when running executable 
files.

For MS-IIS 5.0 you need to put the OvServiceExport.exe file in a 
directory where the Web Server can start CGI scripts. The default 
directory is scripts. You need to modify the OvServiceExport.exe file 
with -cgi cgi root for this directory, for example: -cgi scripts. You 
will need to specify the user and accounts authorized to start the cgi 
scripts.

1. Start the Internet Services Manager. From the Start button, 
select Programs, Windows NT®4.0 OptionPack, Microsoft 
Information Server, and then Internet Services Manager. For 
Chapter 228



Installation
OpenView Operations for Windows Server
Windows 2000, from the Start button, select Settings, Control 
Panel, Administrative Tools, and then Internet Services 
Manager.

2. Open Default Web Site.

3. Click scripts. On the right portion of the screen you will see the 
content of the scripts directory.

4. Right-click scripts and then select Properties.

5. In the Virtual Directory tab verify that the Execute Permission 
parameter is set to Scripts and Executables and click OK.

6. Right-click OvServiceExport.exe on the right side of the window 
and then click Properties.

7. Open the File Security tab.

8. Click on Edit in the Anonymous access and authentication 
control rubric.

9. Enable Anonymous access and click Edit.

10. Specify a user that has the rights to access OpenView Operations for 
Windows services, for example: \Management Server\HP-OVE-User 
and the user’s password.

11. Close every window with OK.

NOTE For additional information review the readme.htm file that is included 
with the OvServiceExport tool.
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Multiple OpenView Operations Servers
To support multiple OpenView Operations servers you will need to:

• Install the OpenView Operations Integration on each server.

• Create a separate account in Service Desk for each OpenView 
Operations server and specify the host name for each account. The 
host name is used when sending acknowledgments and annotations 
to the OpenView Operations server. For example:

Account Host

OVO_account1 server1.yourdomain.com

OVO_account2 server2.yourdomain.com
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3 OVO for Windows and Service 
Desk Configuration

Configuration tasks need to be performed on the Service Desk and the 
OVO servers. Some default settings and values are provided. 
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This section explains the configuration steps that must be done in 
Service Desk. The tasks are listed below:

• Import managed nodes as configuration items.

• Import services as configuration items.

• Modify the import mapping for events (forwarded messages).

• Run the database scripts to prepare for the integration

The following will be created automatically:

• OpenView Operations Integration account

• The environment variable for Service Desk

• Database rules

• Smart actions

• The environment variable, SD_OVWHOME.

The following configuration tasks need to be done in the OpenView 
Operations for Windows application:

• Modify the sd_event.ini file.

• Modify the forwarding policy (not mandatory).

• Deploy the forwarding policy.

• Deploy monitoring policies.

• Deploy opcmsg. 

• Configure OpenView Operations tool for viewing configuration items.

Creating an OpenView Operations Server Account

Every OpenView Operations server that will be integrated with Service 
Desk needs to have a Service Desk account. Windows servers need to 
have an account starting with OVW. The account and host name of the 
OpenView Operations server is used by the database rules to register 
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and send acknowledgments and annotations to the OpenView 
Operations servers. Default accounts will be created when you install 
your database.

Keep the following in mind when creating accounts for each OpenView 
Operations server you will integrate with Service Desk:

• Accounts must start with OVO, followed with the server host name, 
for example OVW_server1.

• Create non-user interface accounts for integrations.

• Access rights need to include the Helpdesk role as a minimum.

For specific information on creating accounts in Service Desk refer to the 
Administrator’s Guide or the Online Help.

Putting the Service Desk Bin folder in the Path

If you want to be able to open a Service Desk form while working in 
OpenView Operations you will need to include the Bin folder in the 
Service Desk path.

A folder called <SD product path>\Client\Bin on a Service Desk client 
installation, or <SD product path>\Server\Bin on a Service Desk 
server, contains the file SDDataForm.bat. This file is triggered by 
OpenView Operations to send a request via the command line to open a 
specified Service Desk data form. This will only work when OpenView 
Operations and Service desk are installed on the same computer. For 
OpenView Operations to find SDDataForm.bat the path must be 
included in the Windows Environment variables. You can add the bin 
folder to the path by performing the following steps:

1. Go to the location where you set environment variables. This differs 
per operating system.

2. Select Path from the list of system variables.

3. Change the value of the path by adding <SD product 
path>\Client\Bin or <SD product path>\Server\Bin to the end 
of the path, which one you add depends on whether you are running 
OpenView Operations on the same machine as the Service Desk 
server or a client. Use a semi-colon as a separator.

4. Click Set when finished, then OK to save it.
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5. Verify that it works by using the DOS command: 
SDDataForm Incident Configurationitem.Searchcode=XXXXX

Where XXXXX is the search code of a configuration item in your Service 
Desk database.

NOTE To start Service Desk in context with SDDataForm.bat, the Service Desk 
Client or Server must be installed on the same machine as OpenView 
Operations.

Importing Nodes Into Service Desk

In Service Desk configuration items need to exist for all nodes managed 
by OpenView Operations. This step needs to be performed so that events 
coming from the OpenView Operations server can find the configuration 
item they are related to in Service Desk. The OpenView Operations 
server is also a managed node. 

NOTE Changing any item in Service Desk, for example adding or changing the 
name of a status used for CIs, effects the import mapping used for 
importing nodes. For the import mapping to work completely you will 
either need to modify the template used for the import mapping and fill 
in the right status with the new values for example, or you can modify 
your Service Desk application to match the import mapping.

Import Mapping for Importing Nodes

The import mapping for importing nodes as configuration items is shown 
with default values in the following figure:
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Figure 3-1 Import Mapping CI Nodes - Windows

For additional information on modifying the import mapping, refer to the 
Chapter entitled “Import Mapping” in the HP OpenView Service Desk: 
Data Exchange Administrator’s Guide.

Configurable Extractor for OVO for Windows Nodes

A configurable extractor is used to define how the nodes should be 
exported from the OpenView Operations database. An example of the 
extractor file, ovowindowsci.ini, with default settings follows:

ovowindowsci.ini file for OpenView Operations for Windows 
and Service Desk integration.
; Used for OVW managed node -> SD CI data exchange.

[DSN]
NAME=             WBEM Source
USR=
PWD=
DBQ=              root\HewlettPackard\OpenView\OVO
Chapter 3 35
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SERVER=
SYSPROPS=         TRUE
NAMESPACES=       {root\HewlettPackard\OpenView\OVO,deep}
UIDPWDDEFINED=    TRUE

[SYSTEM]
LOG=              TRUE
XML=              TRUE
LOG_FILE=         C:\temp\OVO_WIN.log
OUTPUT_FILE=      c:\temp\OVO_WIN.txt
XML_OUTPUT_FILE= c:\temp\OVO_WIN.xml
APPLICATION_NAME= OVO

[CLASSES]
NAME=             MANAGED_NODE

[MANAGED_NODE]
SOURCE=           OV_ManagedNode
ATT=              PrimaryNodeName, Caption, __RELPATH
COLUMNS=          OV_ManagedNode.PrimaryNodeName, 
OV_ManagedNode.Caption, OV_ManagedNode.__RELPATH
LOADTABLE=        TRUE

Importing Nodes From OpenView Operations for Windows

A Data Exchange Task is configured in the demo database for performing 
this action. Nodes can be imported from the Service Desk application 
server as follows:

NOTE To create a WBEM ODBC source driver, WMI version 1085 core 
components are required:

• For Windows NT 4 systems, install the WBEM ODBC source driver, 
available on the VantagePoint Installation CD-ROM as 
\wmi\wmicore_1085.exe

• For Windows 2000 systems, install theh WBEM ODBC source driver, 
available on the Windows 2000 professional CD-ROM in 
\Valuadd\Msft\Mgmt\Wbemodbc.
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1. Create an ODBC link. From the Windows control panel, click 
Administrative Tools then ODBC Data Sources. Open the System 
DSN tab and select the WBEM Source:

Figure 3-2 ODBC Data Source Administrator dialog box

Figure 3-3 Setup WBEM ODBC Datasource

2. Use the Data Exchange task ovowindowsci (for Windows servers) to 
import all managed nodes as configuration items. 
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Figure 3-4 Importing Managed Nodes - Windows

3. Check the log files ovowindows_exp.log and 
ovowindowsci_imp_error.log for errors.

For additional information about how to use Data Exchange for 
exporting and importing data, please refer to the HP OpenView Service 
Desk: Data Exchange Administrator’s Guide.

Multiple OpenView Operations Servers

If the OpenView Operations for Windows server and the Service Desk 
application server are not located on the same machine, choose one of the 
two following options:

Option 1:

1. On the Service Desk application server, install the Microsoft WMI 
SDK. It is available from: http://msdn.microsoft.com/downloads/ 
This contains the WBEM ODBC driver.
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2. Modify the files ovowindowsci.ini and ovowindowsservices.ini. 
Under the DSN section, locate the Server=keyword. Specify the 
OpenView Operations server as the value, for example 
\\MYOVOSERVER.

3. Export and import the data on the Service Desk application server.

Option 2:

1. Install the Service Desk client, including data exchange and the files 
ovowindowsci.ini, and ovowindowsservices.ini on the 
OpenView Operations server.

2. Export the data on the OpenView Operations server.

3. Move the resulting XML file to the Service Desk application server.

4. Import the data on the Service Desk application server.

Manually Creating a Configuration Item 

You can manually create Configuration Items in Service Desk for all or 
part of your managed nodes. To create a configuration item for a 
managed node:

1. Open a new Configuration Item dialog box. This can be done by 
selecting Configuration Item from the shortcut bar or selecting 
New then Configuration Item from the File menu.

2. In the search code field, enter the name of the managed node. 

3. In the Name 1 field, enter the complete host name for the managed 
node:
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Figure 3-5 Configuration Item dialog box

Importing Services Into Service Desk

In Service Desk, configuration items can be made for OpenView 
Operations services. A Data Exchange Task is provide with the 
integration for performing this action. Services can be imported from the 
Service Desk application server as follows:

1. Create an ODBC link. From the Windows control panel, click ODBC 
Data Sources. Open the System DSN tab and select the WBEM 
Source.

2. Update the DSN section of the ovowindowsservices.ini file.

3. Verify that the Operational Level Service category is included in 
the OVOService template. See “Creating the Operational Level 
Service Category” on page 41 for details.
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4. Use the Data Exchange task ovowindowsservices (for Windows 
servers) to import all managed nodes as configuration items. 

5. Check the log files ovowindows_exp.log and 
ovowindowsci_imp_error.log for errors.

NOTE Limitations exist when mapping fields in OpenView Operations for 
Windows to a Service Desk Search code. The WMI ODBC driver requires 
search codes to be written in uppercase letters without spaces. A default 
attribute value called OVOIndowsCI is present in the import mapping as 
a solution to this limitation. If you are importing services from OpenView 
Operations to Service Desk the caption field in the OVO may contain 
spaces and/or wildcard characters which are not allowed in the search 
code field of Service Desk and will result in errors in the import log file. 
As a result, when an external OpenView Operations for Windows 
attribute is imported that contains spaces or is not in uppercase, the 
default value will be given. Attributes in the wrong format will be given 
the default value while others meeting the ODBC driver’s criteria will be 
imported with their true values.

Creating the Operational Level Service Category

The Operational Level Service category may already be included in 
the OVOService template in your database. The category is used when 
you import OpenView Operations services as Service Desk configuration 
items. 

To create the category and add it to the template if it is not present:

1. From the Tools menu select System, then click Data, then Codes, 
and Configuration Item from within the Administrator Console.

2. Click CI Category, then right-click in the screen and select New CI 
Category from the menu that appears.

3. In the New CI Category dialog box enter Operational Level 
Service, in the Text field and leave the Parent field empty:
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Figure 3-6 New CI Category

4. Verify that there is no checkmark in the Blocked check box, and click 
Save and Close:

Figure 3-7 CI Category Operational Level Service

5. Next, you will need to add the new category to your OVOSERVICE 
template. From the Data folder select Templates, then 
Configuration Item. Open the OVOSERVICE template:
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Figure 3-8 OVOSERVICE - Template

6. Double-click the Category entry and use the Quick Find feature to 
locate the Operational Level Service category you created.

7.  Select the Operational Level Service category and click OK to 
add it to the template.

Modifying the Import Mapping for Events

An import mapping with default values, called ovowindows, is provided 
for the OpenView Operations integration, you can modify the import 
mapping as needed.

OpenView Operations message attributes are mapped to Service Desk 
incident attributes. 
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For detailed information on modifying or creating a new import 
mapping, refer to theHP OpenView Service Desk: Data Exchange 
Administrator’s Guide. 

The default import mapping can is shown in the following dialog box:

Figure 3-9 OVO Windows Mapping

Mapping Event Information for Windows

You can send event information from OpenView Operations to Service 
Desk using the WMI policy that intercepts OV_Messages and uses a 
Visual Basic script called Ovo-Sd.vbs to call sd_event and forward some 
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of the attributes to Service Desk, creating a corresponding incident in 
Service Desk. The policy must be deployed on the OpenView Operations 
management server machine. The attributes are mapped as follows:

Configuring Database Rules

Database rules can be used to send information from Service Desk to 
OpenView Operations. A Service Desk agent must be running on each 
OpenView Operations server to execute the commands specified in the 
rules. The following sections contain example for setting up rules to send 
annotations and acknowledgments.

NOTE Clear the Blocked check boxes for the action and for the rule to activate 
them.

Table 3-1 Default Attribute Mapping - Windows

Properties
Message Attributes Fields

Id Event_id

Text (first 80 char) Description

Original message Information

Original text Information

Application Information

Object Information

Annotation 1 - Annotation n 
(concatenated)

Information

OV_Message.GetInstruction() Solution

OV_ManagedNode.PrimaryNodeN
ame

CI

Severity Impact (mapped)
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Send Acknowledgment to OpenView Operations for Windows

You can configure a database rule to send acknowledgments to OpenView 
Operations for Windows as follows:

Figure 3-10 Database Rule to Send Acknowledgment to OVO for Windows

• For each modified incident;

• if [Registration; Create by; Login name]starts with OVW;

• and status is changed to closed;
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Figure 3-11 Action to Send Acknowledgment to OVO for Windows 

• on Host: [Registration;Created by;Host]

• execute the command: cscript

• with the parameters: 
/NoLogo "\"%SD_OVWHOME%\\bin\\Ovo-Sd.vbs\"" [Source ID] 
OV_MessageUpdate_Acknowledge

Send Annotations to OpenView Operations for Windows

You can configure a database rule to send annotations to OpenView 
Operations for Windows as follows:
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Figure 3-12 Database Rule to Send Annotations to OVO for Windows

• for each inserted incident;

• if [Registration; Created by;Loginname] starts with OVW;
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Figure 3-13 Action for Sending Annotations to OVO for Windows

• execute on host: [Registration; Created by;Host]. 

• the command: cscript

• with parameters:
/NoLogo "\"%SD_OVWHOME%\\bin\\Ovo-Sd.vbs\"" [Source ID] 
OV_MessageUpdate_AddAnnotation "\"A Service Desk incident 
has been created with number [ID]\""

TIP Create new database rules quickly by using the copy and paste functions. 
Select a rule that is similar to the rule you want to create and click 
CTRL+C then CTRL+V to make a copy. Double-click the copied rule to open 
it and then use the database rules Wizard to change the parameters and 
the name.
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View OpenView Operations State from Service Desk

You can view current OpenView Operations Service State from a browser 
in Service Desk. See “Installing the HTML Service Viewer” on page 28, 
and “Viewing OpenView Operations Service State” on page 72 for more 
information.

NOTE If you are using smart actions to view service statuses, your OpenView 
Operations Web site needs to be entered in the parameters portion of the 
smart action. Normally the Web site will be the same as your OpenView 
Operations server.

TIP A number of functions available with this integration use the Smart 
Actions feature in Service Desk. To create a new Smart Action:

1. From the Tools menu, select System, then click Business Logic, 
Actions, then Smart Actions.

2. Click the item that you want to create a smart action for. For 
example; a configuration item or a Service Call.

3. Right-click and select New Smart Action from the popup menu.

Additional information on setting up and using Smart Actions can be 
found in the Online Help for Service Desk. 

Generate an OpenView Operations Message from 
Service Desk

The Generate OVO message manually Smart Action can be used to 
forward an Incident to the OpenView Operations operator. If configured 
correctly this manually generated message will not cause the automatic 
trouble-ticket interface in OpenView Operations to generate a new 
incident in Service Desk. 

First make sure the OpenView Operations Agent is installed on the 
OpenView Operations Management Server. The default location is: 
C:\program files\hewlett-packard\openview\service desk 
4.0\agent
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The opcmsg application can be found in the same folder. The system 
environment variable PATH contains the exact path to this program, so 
that it can be called without specifying the folder location. The opcmsg 
application can be used to forward field information from a Service Desk 
incident to the OpenView Operations Management Server. 

To set up the opcmsg application:

1. Open the Administrator Console in Service Desk, then click Business 
Logic, and then open Applications.

2.  Right-click and select New Application from the menu. Define the 
application as shown in the following dialog box:

Figure 3-14 Opcmsg Application

3. Next, create a Smart Action using the opcmsg application as follows:
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Figure 3-15 Generate OVO Message Manually

The parameters entered determine what information from the Incident 
will be passed to the OpenView Operations application. The parameters 
use the OpenView Operations application’s opcmsg syntax. In the 
example above a equals Application, and o equals Object. 

Your system administrator will need to provide access to this smart 
action for all clients that will be using it. The opcmsg command will also 
need to be deployed to the host machines of the Service Desk clients that 
will use the command. Only then will it be possible to execute opcmsg to 
log an event in the OpenView Operations Management Server’s Active 
messages window from remote client machines.

For more information on deploying opcmsg, see “Deploying Opcmsg to 
Service Desk Clients” on page 56.

To stop OpenView Operations from forwarding the message to Service 
Desk, creating a duplicate incident, the Forward Message to Service 
Desk policy should be configured so that it does not forward messages to 
Service Desk that originated from Service Desk. The messages will 
remain in the OpenView Operations browser.
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OpenView Operations for Windows
This section explains the configuration tasks to be done in the OpenView 
Operations application. For an overview of all configuration tasks, see 
“Overview” on page 32.

Setting the Environment Variable for OpenView 
Operations

The environment variable needs to be set on your OpenView Operations 
for Windows application server. To set the variable:

1. Go to the location where you set the environment variables for your 
Windows operating system.

2. Click OK when finished.

3. Install the Service Agent.
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Figure 3-16 System Properties - SD_OVWHOME

Modifying the Configurable Extractor File

Modify the configurable extractor, sd_event.ini. The default location is: 
C:\Program Files\Hewlett-Packard\OpenView\service desk 
4.0\integrations\OVW\bin . Many of the items will be configured 
automatically for you during the installation process. You will want to 
update the ACCOUNT and SERVER entries, as a minimum. If you changed 
the name of the import mapping supplied with this integration, you will 
need to enter the new name in the MAPPING row. A copy of the example 
sd_event.ini file follows:
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[SD_Event]
LOGFILE=C:\OVOSD\log\sd_event.log
ERROR_LOGFILE=C:\OVOSD\log\sd_event_error.log
ACCOUNT=OVW_server1/Servicedesk
SERVER=your server
PORT=30980
MAPPING=ovwindows
CLASSNAME=incident
MODUS=insert

Modifying the Forwarding Policy

The policies called Forward message to Service Desk and Forward 
message changes to Service Desk are configured to forward all major 
and critical messages that are not log only. You can specify what 
messages are forwarded by editing the conditions of the policy. To edit 
the policy:

1. Right-click on the Forward message to Service Desk policy and select 
All Tasks, then Edit.

2. In the Rules tab, click Modify. 

3. Click Add or Modify to change the conditions for each rule.

For additional information refer to the Online Help in your OpenView 
Operations for Windows application.

Deploying the Forwarding Policies

The policies called Forward messages to Service Desk and Forward 
message changes to Service Desk need to be deployed on your 
application server every time you make a change. To deploy the policy:

1. Right-click on the policy and select All Tasks, then Deploy On.

2. Select your management server node you want to deploy it on.

3. Click OK.

For additional information refer to the Online Help in your OpenView 
Operations for Windows application.
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Deploying the Monitoring Policies

Policies are supplied to monitor this integration. After installing the 
integration you need to deploy the policies to the proper locations. The 
list below shows the policies and where they need to be deployed:

Deploying Opcmsg to Service Desk Clients

Opcmsg is used to create OpenView Operations messages from Service 
Desk. You need to deploy this policy to all Service Desk clients that you 
want to be able to perform this function from. To deploy the policy:

1. In the OpenView Operations management console, open Policies 
grouped by type.

2. Open the Open Message Interface policy group.

3. Select the opcmsg policy, right-click and then select All Tasks, then 
Deploy on. 

4. Select all of the Service Desk client nodes that you want to be able to 
manually create VantagePoint messages from and click OK.

For additional information refer to the Online Help in your OpenView 
Operations for Windows application.

Configuring OpenView Operations Tools

An OpenView Operations tool is supplied with this integration for 
viewing Service Desk configuration items when you have the related 
node selected in OpenView Operations. After installing the integration, 
you need to configure the target nodes for the tool. Tools can be:

• run on the nodes you specify;

• configured to permit users to choose the nodes on which the tool will 
run;

• run in the context of a service (run on the node that hosts that 
service).

Monitor sd_event logfile OpenView Operations management 
server

Monitor Service Desk logfile Service Desk server
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Use the Target tab in the Tool Properties dialog box to select the nodes 
on which you want the tools to run. You must also specify Node List in 
the Execute On list. This configures the tool to run on all the nodes in 
the Predefined Node List. 

If you prefer to allow your users to determine where a tool is to be run, 
you must choose Selected Node in the Execute On list. When the tool is 
executed, a list appears from which users choose the location (service or 
node) where the tool will run.

For additional information on using OpenView Operations Tools, refer to 
the Online Help in the OpenView Operations for Windows application.

Viewing Service Desk CIs from OpenView Operations

This section shows how to configure an OpenView Operations for 
Windows tool to open a Service Desk configuration while working in 
OpenView Operations. 

In your OpenView Operations for Windows application:

1. Open the Tool Properties dialog box and enter a name for the tool in 
the General tabbed page:

Figure 3-17 Show Configuration Item - General tab
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2. Open the Details tabbed page and enter Executable in the Command 
Type field:

Figure 3-18 Show Configuration Item - Details tab

3. In the Command field enter SDDataForm.bat. This is the Service Desk 
program capable of opening a dialog box. You will need to have put 
the Bin folder in the path for the OpenView Operations to find 
SDDataForm.bat, see “Putting the Service Desk Bin folder in the 
Path” on page 33.

4. In the Parameters field enter "Configuration Item" "Search 
code=$OPC_NODES".

If you used the default import mapping to import node information, 
PrimaryNodeName data is imported into the Configuration Item field 
Searchcode. It is recommended that you use unique search codes to 
prevent errors.

5. In the Target tabbed page enter Console in the Execute On: field. 
This will allow the program to interact with your console:
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Figure 3-19 Show Configuration Item - Target tab
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4 User Tasks

This chapter provides some examples of how this integration can be 
used. Each section contains at least one use case and lists the steps for 
performing the task for OpenView Operations for Windows. 
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Importing Nodes into Service Desk
OpenView Operations nodes are equivalent to configuration items in 
Service Desk. For Service Desk to relate incidents to a piece of 
equipment that equipment or node needs to be registered as a 
configuration item. Data Exchange is used to automate the process of 
extracting the node data from OpenView Operations and import the 
nodes as configuration items in Service Desk. 

OpenView Operations for Windows

To export nodes from OpenView Operations for Windows and import 
them as configuration items in Service Desk use the Data Exchange task 
called ovowindowsci from the Service Desk application server. For 
configuration information see “Importing Nodes Into Service Desk” on 
page 34. 
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Importing Services and Relations
OpenView Operations service information can be imported as 
configuration items into Service Desk using the Data Exchange feature. 
This makes it possible to relate Service Desk incidents to OpenView 
Operations services. Dependency and composition relations are also 
imported. Dependency relations are horizontal, for example the 
purchasing system and the human resource department are both 
dependent on an Oracle database. Composition relations are parent-child 
relations, for example E-mail service is the parent of the US E-mail 
service and European E-mail service. The relations are added to the 
Related CIs field of the configuration item when they are imported.

OpenView Operations for Windows

To export nodes from OpenView Operations for Windows and import 
them as configuration items in Service Desk use the Data Exchange task 
called ovowindowsservices from the Service Desk application server. 
For specific information see “Importing Services Into Service Desk” on 
page 40.
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Sending Events From OpenView Operations
Service Desk can be used as the Trouble Ticket interface for OpenView 
Operations. You can configure OpenView Operations to send all events or 
specific events to Service Desk. The event information is mapped to a 
Service Desk incident. The first time an event is sent an incident is 
created in Service Desk. Service Desk is then the owner of that event. 
The import mapping in Service Desk defines which event attributes will 
be imported into the Incident fields.

OpenView Operations for Windows

If you are using OpenView Operations for Windows you can send event 
information from OpenView Operations to Service Desk using the WMI 
policy called Forward messages to Service Desk that intercepts 
OV_Messages and uses a Visual Basic script called OVO-Sd.vbs to call 
sd_event and forward attributes to Service Desk. SD_event creates a 
corresponding incident in Service Desk. The policy must be deployed on 
the OpenView Operations management server.

To send event information from the OpenView Operations for Windows 
management console to Service Desk:

1. Configure the integration, see “Deploying the Forwarding Policies” 
on page 55.

2. Once configured, event information that meets the conditions set for 
the policy will automatically be sent to Service Desk. To change what 
message information is sent to Service Desk you will need to modify 
the conditions and distribute the changed policy to your client 
computers. See “Modifying the Forwarding Policy” on page 55.

3. After a message is sent to Service Desk, the severity label will turn 
white to show that it is owned by Service Desk. 
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Reflecting Updates Done in OpenView 
Operations
Changes made to OpenView Operations messages from the OpenView 
Operations windows management console or the API will be reflected in 
Service Desk. 

OpenView Operations for Windows

A WMI policy that registers the event class OV_Message_ChangeEvent is 
used. When a message change occurs, for example severity change, 
message text change, the sd_event program in Service Desk will be 
called to update the corresponding incident.

To reflect updates done in OpenView Operations for Windows in your 
Service Desk application:

1. Install and configure the integration.

2. Once the Forward message changes to Service Desk policy is 
distributed, message updates will be sent to Service Desk 
automatically. The import mapping determines what attributes are 
sent to Service Desk.
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Manually Forwarding Messages
This feature makes it possible for users to send a message to the Service 
Desk application. A message may need to be manually forwarded when:

• A message is created that was not detected by the automatic fault 
detection application.

• A message is created that is not configured to be sent to Service 
Desk.
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Sending Annotations to OpenView Operations
Annotating a message in OpenView Operations is similar to adding a 
note of explanation to a business contract. The annotation is a short 
summation of the important points and can be used as a reference the 
next time you receive the same message. Message annotations are 
normally used to provide information on:

• action performed to resolve the problem;

• name of the user who started the action;

• status information for the action performed;

• start and finish time of the action;

• any pre- or post action information which is relevant.

Database rules are available in the demo database for sending an 
annotation to OpenView Operations whenever an incident is created as a 
result of an event being sent from OpenView Operations to Service Desk. 
The database rule can also be configured to send an annotation to the 
OpenView Operations application whenever the status of that incident 
changes. Database rules can be turned on/off and modified from the 
Service Desk. Agents on the OpenView Operations server are sent 
commands, generated from a database rule in Service Desk, that call the 
OVO-Sd.vbs script (Windows) in OpenView Operations.

OpenView Operations for Windows

To send annotations to OpenView Operations for Windows from Service 
Desk:

1. Install the demo data and configure the integration, see “Send 
Annotations to OpenView Operations for Windows” on page 47.

2. Turn on the database rule, send annotations to OVO for 
Windows: 

• From the Tools menu in Service Desk (server) select System. In 
the Administrators Console navigate to the Business Logic 
folder and open Database Rules. Double-click the Incident 
item. 
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• Annotation rules are available for OpenView Operations for 
Windows; make sure you use the correct one. Open the rule and 
use the Database Rule wizard to verify that the definition for the 
rule is accurate and that the rule is not blocked.

Once the rule is configured and turned on (not blocked) it will 
automatically send annotations to OpenView Operations. 
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Sending Acknowledgments to OpenView 
Operations
Acknowledging a message is similar to filing a bill after it is paid. You 
want to retain a copy of the transaction to verify that you have paid the 
bill, and as a reference to compare with future bills. After you have 
finished working with a message you remove it from your desktop and 
file it away for easy future reference. Typically you acknowledge a 
message because:

• You have finished work on the message and resolved any related 
problems.

• You have another message in your Message Browser describing the 
same event.

• You no longer need the message, for example, if the message has low 
severity and requires no action.

Database rules are available in the demo database for acknowledging 
messages from OpenView Operations whenever an incident that was 
created as a result of an OpenView Operations event is closed in Service 
Desk. Database rules can be turned on/off and modified in the Business 
Logic section of the System Administrator’s Console. Agents on the 
OpenView Operations server are sent commands, generated by a 
database rule in Service Desk, that call the OVO-Sd.vbs script in 
OpenView Operations.

OpenView Operations for Windows

To send acknowledgments to OpenView Operations for Windows from 
Service Desk:

1. Install the demo database and configure the integration, see “Send 
Acknowledgment to OpenView Operations for Windows” on page 46.

2. Turn on the database rule, send acknowledgments to OVO for 
Windows: 

• From the Tools menu in Service Desk (server) select System. In 
the Administrators Console navigate to the Business Logic 
folder and open Database Rules. Double-click the Incident 
item. 
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• Acknowledgment rules will be visible for OpenView Operations 
for Windows; make sure you use the correct one. Open the rule 
and use the Database Rule wizard to verify that the definition for 
the rule is accurate and that the rule is not blocked.

Once the rule is configured and turned on (not blocked) it will 
automatically send annotations to OpenView Operations. 
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Viewing Service Desk CIs from OpenView 
Operations
While working in OpenView Operations for Windows you can view 
related configuration items in Service Desk. 

The View Node Info action opens the configuration item form in Service 
Desk. The node selected is passed as a parameter using $OPC_NODES. 
The application can only be started with the Windows user interface.

See “Viewing Service Desk CIs from OpenView Operations” on page 57 
for information on how to set up the tool to perform this action in 
OpenView Operations.

TIP If the Service Desk dialog box does not open, verify that the Bin folder is 
in the path. For more information see “Putting the Service Desk Bin 
folder in the Path” on page 27.

OpenView Operations for Windows - View 
Configuration Items

To call the Service Desk user interface when you are working in the 
OpenView Operations for Windows management console:

1. Select the node that you want to view as a configuration item in 
Service Desk.

2. Right-click and select All Tasks, then Launch Tool.

3. In the Tool to Execute dialog box select Show Configuration Item 
in Service Desk Client. 

4. Click Launch.
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Viewing OpenView Operations Service State 
A browser can be used to view all services that are not working or just 
top level services that are not working, depending on the URL used. The 
services are color coded to show the level of importance: red equals 
critical; orange equals major; yellow equals minor; and light blue (Cyan) 
equals warning. The following scenarios are designed to give you an idea 
of how this feature might be used:

• A support manager wants an update on the state of the top level 
OpenView Operations services that are down. The manager clicks 
the Top OVO services shortcut on the desktop and gets a view of all 
top level services currently down.

• A specialist is working at a customer site and needs an update on the 
services that are down. The specialist enters the service viewer URL, 
in the browser of a computer with Internet access, and gets a view of 
all services that are down. 

• The customer support center begins to receive numerous calls for 
service. To get a quick overview of services that are currently down 
the help desk engineer uses the Service viewer shortcut on the 
desktop to quickly locate the down service and answer the calls.

OpenView Operations on Windows

In Service Desk, add a shortcut to view the overall state of OpenView 
Operations services. To create the shortcut:

1. From the Start menu select Programs and then left-click on the 
entry for Service Desk 4.0. 

2. Select Add Shortcut from the popup menu that appears.

3. In the Name field, enter the name you want the shortcut to have and 
select the URL option with the following URL: 
http://server/cgi-bin/ovserviceexport.exe?-format+html[+
-service+service name.]

For viewing top services, remove the service name from the end of 
the URL.

4. Click OK to save the shortcut. 
Chapter 472



User Tasks
Viewing OpenView Operations Service State
5. When you click on the shortcut a hierarchical view of services will be 
visible. Click each service to view more detail information. The view 
will be refreshed every sixty seconds.
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Generating an OpenView Operations Message 
From Service Desk
If a helpdesk employee becomes aware of a problem in the IT 
infrastructure and creates an incident in Service Desk. However, an 
error message does not exist for the problem in the OpenView Operations 
application. The helpdesk employee, can use a smart action in Service 
Desk to pass the incident information to the OpenView Operations 
application, creating a new error message in OpenView Operations. 

OpenView Operations for Windows

To generate an OpenView Operations message from the Service Desk 
user interface:

1. Select or open an incident in Service Desk.

2. From the Actions menu in Service Desk click the Generate OVO 
message manually action.

3. A new message will be created in OpenView Operations.
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Monitoring Service Desk Processes
OpenView Operations log file policies can be used to monitor the log files 
for sd_event, and the Service Desk application server. This provides you 
with a means for monitoring the integration continuously. The policies 
can be used to match specific log file lines and assign variables out of the 
intercepted lines to use for pattern matching.

OpenView Operations for Windows

Once the policies are deployed, detected errors are sent to the message 
browser automatically. Instructional text is provided with the error 
messages to help solve detected problems. The policy monitor sd_event 
logfile is used to monitor the OpenView Operations management 
server. The policy Monitor Service Desk logfile is available for 
monitoring the Service Desk application server.
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5 Troubleshooting

This chapter contains troubleshooting information for using the 
OpenView Operations operation for Windows with Service Desk.
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Troubleshooting Information
This section contains information that may be helpful in locating and 
solving errors that occur when using this integration.

Potential Windows Error Messages

This section explains error messages you may encounter in 
sd_event_error.log, followed by a possible solution.

Viewing Items Error

Error message: You are not allowed to view this type of item.

Solution:

1. From the Tools menu in Service Desk, click System, then Security, 
then Access, and Role.

2. Open the Helpdesk role and select View access for the Account 
item.

3. Click OK and then restart the Service Desk application server.

Server Response Error

Error message in sd_event_error.log.
SERVER RESPONSE=ERROR: null criteriu

Solution: This error occurs when the OpenView Operations message can 
not be accessed by the get_ovo_attributes command. Verify that you 
have added Service Desk (SD) as a user in OpenView Operations with 
the correct password and that the Service Desk user has access to 
messages. 
Chapter 578



Troubleshooting
Troubleshooting Information
Integration Item Reference List

The following tables are provided to give you an overview of the various 
files and configured items included in this integration and their use. The 
tables include the various import mappings, configuration files, policies, 
database rules, smart actions and other key tools provided with this 
integration:

Table 5-1 Configuration (ini) Files

Name Use

sd_event.ini For importing events into 
Service Desk.

ovowindowsci.ini For importing OVO for 
Windows nodes as 
configuration items into Service 
Desk.

ovowindowsservices.ini For importing services from 
OVO for Windows into Service 
Desk.

Table 5-2 Import Mapping

Name Use

sd_event For mapping OVO events to 
Service Desk (Incident) item 
and attributes.

ovowindowci For mapping OVO for Windows 
nodes to configuration item and 
attributes in Service Desk.

ovowindowsservices For mapping services from 
OVO for Windows to Service 
Desk configuration items.
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Table 5-3 Database Rules in Service Desk

Name Use

Send acknowledgments to OVO 
for Windows

For sending an 
acknowledgements to 
OpenView Operations for 
Windows.

Send annotations to OVO for 
Windows.

For sending annotations to 
OVO for Windows.

Table 5-4 Smart Actions in Service Desk

Name Use

Show OVO for Windows service 
state

To view the state of OpenView 
Operations for Windows 
services with a Web browser.

Table 5-5 Policies in OVO for Windows

Name Use

Forward messages to Service 
Desk

To forward a message from 
OpenView Operations to 
Service Desk.

Forward message changes to 
Service Desk

To forward message changes 
from OpenView Operations to 
Service Desk.

Monitor Service Desk log file To monitor the Service Desk log 
file for errors.

Monitor sd_event log file To monitor the sd_event log file 
for errors.
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Table 5-6 Tools in OVO for Windows

Name Use

Show Configuration Item in 
Service Desk Client

To view the configuration item 
in Service Desk that is related 
to the node selected in 
OpenView Operations.

Table 5-7 Accounts in Service Desk

Name Use

OVW_server1/servicedesk Default account created for the 
OpenView Operations for 
Windows server. Server 
accounts must start with OVO.

Table 5-8 Monitoring Policies in OVO for Windows

Name Use

Monitor sd_event logfile For monitoring sd_event on the 
OpenView Operations 
management server.

Monitoring Service Desk 
Logfile

For monitoring the Service Desk 
application server.

Table 5-9 Service Desk Server

File Default Location

 ovowindowsci.ini Service Desk product 
path\data_exchange\config

ovowindowsservices.ini Service Desk product 
path\data_exchange\config

sd_access.exe Service Desk product path\bin
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Table 5-10 OpenView Operations Server - Windows Platform

File Default Location

sd_event.exe OpenView Operations 
Product PathC:\OVOSD\bin

sd_event.ini OpenView Operations 
C:\OVOSD\bin

Ovo-Sd.vbs OpenView Operations 
C:\OVOSD\bin

queuectl.exe
enqueue.exe
dequeue.exe

OpenView Operations 
C:\OVOSD\bin

Monitor Service Desk logfile 
(policy)

OVO database

Monitor sd_event logfile 
(policy)

OVO database

Forward messages to Service 
Desk (policy)

OVO database

Forward message changes to 
Service Desk (policy)

OVO database
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